SIMULALION X vy G

Tutorial 1

Getting Started

Objective

The following tutorial is a step-by-step introduction to the basics of
SimulationX. You will first get an overview of the graphical user interface
(GUI) with the help of an example model which you can open on your com-
puter. In the second part, you will learn in seven steps how to create a simple
model as the basis for the third part explaining in eleven steps how to extend
and modify existing models (including post-processing).

Prerequisites

The following explanations and screenshots are based on the default set-
tings of a newly installed trial version of SimulationX Professional Edition. You
can reproduce all further steps with this version on your screen.

Part I: If you are using a commercial license, make sure to have the libraries
MBS Mechanics (3D) and Hydraulics installed. Otherwise, simply read through
Part | or view the sample model with the Viewer Edition.

Parts Il and Ill: Apart from the Basic Module, no other modules are required.
The models in Part Il and Il can also be created with the Student Edition. The
Viewer and Student Editions are both available for free and can be downloaded
in the Customer Center (www.simulationx.com/customer-center).

To change the edition, go to: £xtras - Options - Licensing
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I. Graphical User Interface (GUI)

Upon installing SimulationX on your computer for the first time, the following window appears after the
first start. The Sample Browser provides a comprehensive collection of sample models from different
applications and domains.

Here, you can choose the model
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Fig. 1: Sample Browser with examples from SimulationX Professional Edition

The following view (with default GUI of SimulationX) and a result window appears on your screen:
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Fig. 2:  Default GUI of SimulationX Professional Edition with a model (Bucket Cylinder Hydraulics) from the SimulationX Sample
Browser

Menu bar: Provides tools to create models and to control the simulation.

Library bar: Provides access to the element types installed and grouped into different topical libraries
in a hierarchical order.

Output area: Displays notifications, warning messages and errors. The content of the output area can
be saved, exported as text and printed.

Parameter table, result table and the components bar: Contains the properties of your model and the
results displayed. (In order to have values displayed in the parameters and result tables as shown in

figure 2, click U on an element in the diagram view).
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Diagram view: Shows the logical structure of the JoirtArmBucket Bucket  JoirtRockerBuckst Rocker
simulation model. In order to create a system mod- - ﬁ "'}"G’l 3
el, model elements are connected with each other - =

through connection lines. Additional information, Rotation LinkL LirkR Arm
such as graphical elements and text, can also be — e ﬁ @
added.

3D view: Shows a three-dimensional visualization JointRockertink
of the model. Some libraries (e.g. Mechanics MBS) =G VY oy
allow you to build models also interactively in 3D.
For the navigation in the 3D view and diagram Bucketforce3D  BRTSaYY

views, see the table below.
Table 1: Hotkeys for the navigation in the diagram and 3D view

1D mechanical - BucketForceCylinder
Action Hotkey QoinEadien d
= h lic
c 2 Move model view Hold {§+ drag connection \ \
oo ¥ ]
8 > | Zoom model view Ctrl + @# hydraulic
e signal element
connection HTL :E:h
Rotate model view Hold [+ dra >< -
| Y reg iBH|Hav
A q;) Move model view Shift + hold @ +drag | /—/: | PUl (4T PropDirvalveds
m .=
S Ctrl + hold [ + drag _ —
Zoom model view < | |® \ T:alnk
alternatively:
&l ©

Pressure

Result window: Shows selected results in a dia-
gram. Values can be read out and further analyses
of the simulation results can be performed.

Fig. 3:  Complete diagram view of the model shown in
figure 2

Figure 3 shows the principal structure of a network
model consisting of model elements from different
libraries and physical domains. Different kinds of
connections link these model elements through
specific connectors.
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For performing your first simulation, press ¥ (Start)
in the menu bar. You then see the results in the
result window (see figure 4), the effects in the 3D
view and the current simulation time in the bottom
right corner.
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Close the model by clicking @ on the tab of the
sample model either in the diagram (see figure 5)
or 3D view and select Close Model. When asked
wether you want to save changes, select No.
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Il. Creating a simple model

In this chapter, you will learn about the basic structure of a network model as well as setting and
changing parameters while creating a simple model of a one-mass oscillator. Furthermore, you will run
a simulation and evaluate the results in a graphical result window.

Creating a model file

Click @ the button NeW in the menu bar or go to File » New. A new, empty diagram view appears.
(To open an existing file, click the button Open IEI in the menu bar or File » Open...)

Dragging model elements into the diagram view

Go to Mechanics - Linear Mechanics in the library bar. Click @ on Spring, hold the mouse button and
drag the element into the diagram view. Release the mouse button.

Library Bar = Mot oo | - x (=] Madel (Mndelt.ico* v x
A. o
ol (il - it Modael [moaer
v [4 SimulationX 3.2 ~ n n
> W Signal Blocks
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5> [ MBS Mechanics v v v
< > |< > < >

Fig. 6:  Placing an element from the library bar in the diagram view by drag and drop

For information about a model element’s physics, click on (Direct Help) in the menu bar. The cur-
sor will change to l} . Click ® on spring? in the diagram view or on Spring in the library bar. A window
will pop up with detailed information about the model element Spring. Close the Help with - (Close)
to proceed with the tutorial.

Now, drag the element Mass from the library Linear Mechanics in the diagram view and drop it there.
Your diagram view should look as follows:

[7] Model (Model1.isx)* | v x

[ Mogel

spring1 massl

art - art
= a2 a2

< >

Fig. 7:  Diagram view with two unconnected model elements (Spring and Mass from the library Linear Mechanics)
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Connecting elements

In order for the elements to be able to interact with each other, they have to be linked through connec-
tions. Activate (Pin Labels) in the menu bar to display the names of the connectors in the diagram
view.

Place the cursor over ctr2 (connector 2) of spring?. The connector turns red and the cursor changes
to R, . Press B, hold the mouse button and drag the connection towards ctr7 of mass? as shown in
figure 8.

springl springl massl springl miassl
ctrl —+ ctrl —+ ctrl ctrl -+ cirl
—+ 2 —+ ctr2 ctr? —+ tr. ctr2

Fig. 8:  Connecting spring? and mass1

Now, place a model element of type Damper from Mechanics - Linear Mechanics in the diagram view.
Connect the model element damper1 with the existing structure as shown in figure 9. You will notice
that you can also connect a connector with an existing connection.

springl massl springl massl
ctrl — ctrl ctrl
—+ cird cird ctr2
damperl
ctrl I —+ ctrl
-+ ctrd —+ I
Fig. 9:  Connecting a model element to another connection
With the created structure, it is already possible to simulate a simple one-mass-oscillator.
Entering Parameters bropertcs - mass1 X
. . . ) Parameters | Results | General | 4 b
The diagram view only shows the interaction of the
different model elements with each other. In order | ™ - |l __]
. . . L. Initial Displacement XD 20 ~ e~ Emi-
to determine the properties of each individual ele- || oo o o [ -

ment, it is necessary to specify the parameters. @ g g 1@

Double-click ) on the element mass? in the dia- ~ Fig 10 Setting parameters of mass
gram view to open the properties window of this

element. Click on the tab Parameters and set the | & propeties - springt %
value for Mass to 5 kg and for Initial Displacement to | peremeters | savanced | Resus | Genersi | a0
20 mm. As m is the default unit for Initial Displace- Stffness k[ |vm <] ™
ment, choose the unit mm in the tab next to the Rigid dgid | false <]
value as shown in figure 10. (Note: If you change |g .G g '@

the unit from m to mm, SimulationX will adapt the
value accordingly [20 m = 20000 mm]. By holding
shift while changing the unit, you can change only

Fig. 11: Setting parameters of spring?

' . . Properties - damperl x
the parameters unlt and nOt ltS \/a'ue [20 m - Parametirs | St'ad--:at';na\--riﬁ | Advanced | Results | General | 4 b
20 mm].) Now, you can close the properties win-
dow Of maSS/I ) Damping b: ‘ZO | |Ns,"m v| [L.0]]
Rigid rigid: | false |
Set the properties for spring? and damper? in the |©@  «=H & . X )

same fashion as shown in figures 11 and 12. Fig. 12: Setting parameters of damper1
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5 Selecting results to be logged and displayed PS— "
Parameters Results | General | 4 b

Before starting a simulation, it is necessary to
choose which specific results - out of all possible
outputs - should be logged for later analyses.

Open the properties window of mass? again and
g0 to the Results tab. Choose Displacement and Ve-
locity as the results to be recorded by clicking 8 on
the corresponding symbol [&]. It will change to [#].
Change the unit of Displacement to mm and close
the properties window (see figure 13).

Starting the simulation

Inertia Force Fa:

Displacement b

Velocity v

Acceleration a

M HERER
3
<

Change of Kinetic Energy Pk:

@ - H g 10
Fig. 13: Properties - mass1: Result logging

To control the simulation and specify its settings, open the Properties dialog [E]in the simulation control

section (see figure 14) in the menu bar.

Transient - F:EE » » -

-

Simulation mode Start simulation

Fig. 14: Simulation control bar

Define the time period of the simulation by setting
Stop Time to 2 s as shown in figure 15 (with the de-
fault Start Time at O s, the system will be simulated
for two seconds).

Press [¥! (Start) to start the simulation.

Working with graphical results

In order to display the recorded results as graph-
ical representation, open the Properties window of
mass1 - Results (see figure 13), drag the symbol
for Displacement and drop it somewhere in the di-
agram view.

A result window as shown in figure 16 appears.

It shows the graphical analysis of the displacement
of mass1 over time.

Simulation properties

Simulativn Cunlrel ®

Solver

istart: [ ] [s

<<

Smbatc Anatyss Scatable Real-Tane Syndtwanization:

Debugging Mo Synchronization -
Tating

Reset Points
Solver, Step Sizes and Tolerances

BUF Method “

Min. Calculation Step Size  atMin; |18 [s ]

Max. Caleulation Step Size  dibax  [(tStop thtart)/ 100

s
Absalute Tolerance sbstor [180s [ ~

Relative Tolerance relfal; (e [ ]
Min. Step Size diDctect:  [athntie 4 f

Recording of Resulls

At leastater ot <]

Min. QUIpUL Step 3iIZe  dtrOtMIN; 0.001 s ]

User Settings

Dackup Restore Reject

o [ ey | e
Fig. 15: Simulation control window
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File Edit View Insert Analysis Options Window 7
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massix

W4 » n \masstx/
Fig. 16: Result window - Displacement of mass1
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Ill. Model extensions, further adjustments and
post-processing

Applying the methods shown in chapter II, you will create a two-mass oscillator and learn about further
adjustments and modification methods as well as post-processing.

1 Create an alternative model structure

Place the element Spring-Damper Backlash and the element Mass from the library Linear Me-
chanics in the diagram view beside your model from chapter Il and connect both new elements.

springl massl

ctrl ctrl
springCamperl

& mass2

ctr2

Fig. 17: Diagram view with two new elements

As you will see in the following steps, the element type Spring-Damper Backlash can represent the same
physical correlation as the single elements spring and damper (depending on the parameters).

2 Change parameters using the parameters table ametes  ax

. . . ) Comment Mame  Current Value Unit S
Select springDamper1 in the diagram view. Its pa- Properties kind  Spring-Damper-...
rameters are now displayed in the parameters ta- Stiffness of Contact k 20000 M/m
# Damping of Contact b 20 Ms/m v

ble (see figure 18).

Fig. 18: Setting parameters of springDamper1 via the

Change their values by double-clicking B in the box Darameters table

with the corresponding value and set the stiffness
of springDamper1 to 20000 N/m and damping to

20 Ns/m. Table 2: Parameters of mass2
Change the properties of mass2 in the same man- | model element ~ parameter value
ner with the values given in table 2.
mass2 Mass (m) 5 kg
SpringDamper1 has now the same properties as
pring P prop Initial 0 mm

the connected elements spring 1 and damper 1.

Displacement (x0)

3 Restart calculation and compare the two models Rews . x

Comment Mame  Current Value  Unit Protocol
Select mass2 and click @ on the result window Inertia Force Fz 0 N =
symbol (€] for the displacement in the results table Voo — m
(figure 19), it will change to [#]. Now drag and drop Acceleration s 0 /st =
the result window symbol for the displacement Change of Knetic Energy Pk 0 kw &

onto the diagram view. _
Fig. 19: Results table of mass2
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As the new model has not yet been simulated, no simulation results are available in the result window.

Reset the previous calculation by clicking (Back to Start) in the menu bar. Restart the simulation
with (Start). You can now compare the displacements of mass1 and mass2. The results should be
identical.
3 maee1x - u x B mase2x - =} x
File Edit View Insert Anabnis  Oplions  Window 7 File Cdit View Inset Analysis Options Window 7
® Q- I [B]l by e = T mmasix . # Q| - ([ b (A b B e mmasas

massix mm mass2x

N\/\W\/\ APAAAAAAA

,/\ PN N A ]

1
[} 1 2 0 1 2

W1 r oy Smasstx W4 r n ymass2x
Fig. 20: Result window of mass1 and mass 2

4 Copy and paste several elements and extend your model

Select springDamper1 and mass2 by drawing a rectangle in the diagram view holding ). Releasing the
mouse button selects all marked model elements.

ingD r
springDampe springDampert

- masss
3 otri otri
o T2 ctr2
ry

+

Fig. 21: Selecting the model structure in the diagram view

Copy the model structure of the one-mass oscillator by dragging one of the selected elements while
pressing and holding ctrl + 8 and drop it in a position as shown in figure 22.

springCamper]

ctr2

springDamper2

&
ctr2
ury

Fig. 22: Copying a model structure by drag and drop

ctri
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As you can see in the corresponding properties
windows, the copied model elements have the
same settings (parameters, results, ) as their cor-
responding archetypes. Link springDamper2 and
mass2 and the structure will look like the one in
figure 23.

Customize the appearance of your network
model

Activate the connection between mass2 and spring-
Damper?2 by clicking  on the connection.

Change the routing of the connection between
those two elements by grabbing a control point
(see figure 24 - the cursor will change to &) and
drag it to a different position.

In order to delete the connection between mass2
and SpringDamper?2, press Shift while hovering over
the connector. As soon as the symbol # appears
next to the cursor (see figure 25), click @ and the
connection with the next element will be deleted.
(Please note: If a selected connection is deleted with
Del, not only the connection between one element
and the next one is deleted, but also all selected
connection lines are deleted.)

(Alternatively: Press (Undo) in order to undo
this change.)

In order to simply move a line parallelly, you can
also grab the line (instead of a point) by hovering
over the selected connection and as soon as the
cursor changes to 4|, you can move the line to a
parallel position (see figure 26).

Please note: The I cursor will only be available if
there are two rectangular bends in this connec-
tion, before the next model element or node (see
figure 27).

Parameterize the copied structure and set simu-
lation parameters through the paramters table

Change the parameters of springDamper2 and
mass3 in accordance with table 3.

Afterwards, change the parameters of the simula-
tion by clicking ® on an empty space in the diagram
view. The parameters for the simulation appear in
the parameters table. Set the values as shown in
figure 28.

springDampert

arl

Fig. 23: Model structure of a two-mass oscillator

Table 3: Parameters of springDamper2 and mass3

Model element Parameter Value
springDamper2  Stiffness (k) 1000 N/m
springDamper?2 Damping (b) 2 Ns/m
mass3 Initial 0mm

Displacement (x0)

Mass (m) 1 kg
springDamperi &

ctrd springCamper2

Fig. 24: Changing the position of a connection point

springDamperl
mass2

ctr, springDamper2

—+ E‘i{:‘ ‘ i

Fig. 25: Cutting a connection between two model elements

N mass2

springDamper2

+ A -

1

Fig. 26: Moving a connection parallely

v [

Fig. 27: Precondition for parallel movement of a

connection
Parameters B X
Comment MName  Current Value Unit ~
Start Time tStart 0 s
# Stop Time tStop 3 5 v

Fig. 28: Parameters table
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7 Run your extended model

Reset the calculation, by clicking IEI Back to Start) in the menu bar. Restart the simulation with IE
(Start). The result window mass2.x will change (see figure 29 [left]) due to the extension of the simula-
tion time in the step before. Click on mass3 and drag the result window symbol (#]) for the displace-
ment into the diagram view. The displacement of mass3 is displayed in a separate window (see figure

29 on the right).

mass2x

File Edit View Insert Analysis Options Window 7

#ocQlh-|[w o A m b [Ee s TE =mes ©

mass3x

File Edit View Insert Analysis Options Window 7

#e Q- [m

by ]t b | F e FE emassax -

mass2x

20

mass3x

b

44 b v ymass2x

Fig. 29: Displacements of mass2 and mass3 in separate windows

8 Merge result windows

44 b v ymass3x

For better comparison of the interaction between both masses, you can display both curves within one
diagram. In order to do this, grab the symbol of mass2.x in its result window and drop it near the center
of the result window of mass3.x as shown in figure 30. (Be careful not to drop mass2.x on one of the
operator buttons in the middle of the window as this will result in both functions to be merged.) Both
curves are now displayed within one diagram. As the graphs have the same units, both share the same

x and y axes.
mass2x [ B i
File [t View Insert Analysis Options Window ? File Fdt View Inset Analytis  Options Window 7
oo - [ L[]0 b b P i B mmsssie E e S N N = e B
g i 3 3
) mH .................................................................
j_' TV n'\f‘;\j "WM/\)}\ j[\ N f\, \/\,m B |
: .m_l\’l..'..... SO NP PO
T | ‘
W \maasax A N \maasix, .
Fig. 30: Merging two result windows
. . T mass3x, .. =
To change the settings of the result WiNdOW, PreSS | . e e et s ot wntor + S
(Property Bar) in its menu bar. By selecting Pan-  {#o- 8 ol i @ e [5] mme
el, you can specify settings like font, font size, line . = Y P

width etc. of the diagram. To improve the contrast
between both graphs, select mass2.x and change
the color to dark blue (see figure 31).

v [ mass2x

Show Points. LmL

W v \masssy .

Fig. 31: Customization of result windows settings

OEOEECNEE

mEmag
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Perform a Fast Fourier Transformation (FFT)

As you could see in figure 29, the vibrational behav-
ior of mass3 was influenced by eigenfrequencies. In
order to analyze the vibrational behavior of both
masses in the frequency domain, there is an option
to perform a Fast Fourier Transformation (FFT) in
the result window.

Click (Fast Fourier Transformation (FFT)) in the
menu bar of the result window. The appearance of
the result window changes as displayed in figure 32.

Take measurements of the graph

Select FFTimass2x)  to activate the frequency
spectrum of mass2. Click 8 in the result window,
hold the mouse button and drag it towards the
blue graph. You will see a crosshair and the exact
values for x and y at the chosen point (see figure
33). As long as you keep the mouse button pushed,
the crosshair is attached to the graph and will fol-
low its course, while the corresponding values are
displayed in the box.

Compare different parameter settings

Click @ on (Freeze) in the result window to pin
an image of the diagram to the background of the
window. Change the stiffness k of springDamper1 to
40000 N/m. Reset the calculation to the start and
restart it. You will now see the results of the calcu-
lation with changed parameters in the foreground
and the ones from the previous calculation slightly
faded to the background (see figure 34).

11112
T massaoc .. - 0o x
File Edit  View Inserl L Analysis  Options  Window 7
o Q- Btk B= B ermmm
FMT{massdx)
FfT{mass2x)
H Hz
(24 oo 100 120
ERANER: o003, -
Fig. 32: Fast Fourier Transformation
FFT(mass2x), .. _ o w
File Edit View |Insert Analysis Options Window 7
#6 Q- | ]l b Y R em B wFeTmas2g
FFT{mass3a)
FFT{massos)
I —_—,—,,,,,,,Y, ]
= .. L |
OV S ;
o 20 40 &0 20 100 H: 120
4 b » \EFT i

Fig. 33: Measurement of explicit values from the graph

EFT(mass2s), . _ o %

File Edit View Insert Analysis Options Window 7

o cQ nh-|H]

Al b ey me =

»FFTmass2.)

o

FFTimass3a)
FFTmassls)

i

0

14+ M \FFT(mass3x), ../

0 40 &0 20 100 120 140

Fig. 34: Two eigenfrequencies with values of a previous

calculation in the background
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Conclusion

In this tutorial, you have learned the basic concepts of building a model. The model's system behavior
was simulated and analyzed. The presented example was taken from the mechanics domain, but the
general approach to creating and analyzing system models is the same for all other physical domains
in SimulationX. Depending on the user’s preferences and the specific requirements for each task, there
are often several ways to solve it. This introductional tutorial gave you a small insight into SimulationX
various features.

If you want to learn more about how to use SimulationX, please take a look at
+ SimulationX Help: Help - SimulationX Help; alternatively click on (Help) or press F1
+ SimulationX User Manual and Library Manual (Help » Documents - User Manual/Library Manual)
Further SimulationX tutorials (Help - Documents - Documents Online )
+ SimulationX training courses: http://www.simulationx.com/academy

-+ Contact our global sales teams: www.simulationx.com/global

ESIITI GmbH + Schweriner StralBe 1 - 01067 Dresden + Germany
info.iti@esi-group.com + T + 49 (0) 351.260 50 - 0 * F + 49 (0) 351.260 50 - 155
www.simulationx.com Doc.-Vers.: 03/2017
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